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Prospective teachers have à positive attitude towards the use of technology in education and a good knowledge of 

the field, but face challenges in its practical integration. The main difficulties include insufficient preparation, 

lack of methodological support and internal barriers such as insecurity and insufficient skills. This paper presents 

a study conducted at the beginning of two consecutive academic years (2023/2024 and 2024/2025) involving 600 

students (398 bachelors and 202 masters) from education majors. The main objective is to assess their information 

technology skills as well as their attitudes towards its application in the learning process.  
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1. INTRODUCTION 
In today's world of rapidly evolving technologies, the role of teachers is transforming, requiring not only 

pedagogical skills but also the ability to effectively integrate information and communication technologies into 

the educational process. Both the teachers and the demands on their competencies are changing [1]. Future 

teachers need to be prepared to integrate information and communication technologies (ICT) into their future 

teaching and learning practices [2, 3]. 

 

Teachers need to be able to create effective learning and teaching environments by selecting technological 
materials appropriate to their expertise in the field and the pedagogical method they will use in their classes, i.e. 

they need to be able to combine technological, pedagogical and content knowledge [4]. Internet technologies 

enrich educational practices by creating dynamic and engaging learning environments, which is essential for 

preparing future labour market professionals for work in the digital age [5]. This suggests that the mere experience 

of activities involving the use of technology can foster positive technology-related beliefs [6]. 

 

Integrating ICT into teacher in-service training programs continues to be a challenge worldwide [7]. This 

necessitates that teacher educators continually analyze their current opportunities and needs and, when necessary, 

access professional learning in response to rapidly changing educational environments and opportunities presented 

by emerging technological innovations [8]. Educational programs and technology must be integrated to enable 

future teachers to acquire the necessary pedagogical skills and strategies [9]. With increased access to the Internet 
and demands on nontraditional teacher education programs, it is important that administrators in higher education 

understand the ways in which they can help teacher educators use instructional technology [10]. As a result, many 

frameworks seek to understand the idea of integrating technology into teacher preparation programs [11]. 

 

When teachers are continuously educated about changing information technologies in pre-service and in-service 

training to improve their abilities to use technology effectively, it helps improve their perceptions and facilitates 

the integration of technology into education [12]. Training, modeling, and mentoring should be part of the teacher 

education curriculum so that university teachers, teacher educators, and preservice teachers have the knowledge 

base and skill level to integrate technology into their teaching practice [13]. Institutions of teacher training should 

offer education that emphasizes the importance of 21st century skills and provide opportunities for future teachers 

to develop skills such as collaboration, creativity, communication, problem solving, critical thinking, and the use 

of technology [9]. Digital literacy defines not only effectiveness in the use of new technical tools and the 
development of electronic resources for educational purposes, but also communication in a virtual learning 

environment, which is an essential element of e-learning and a factor in its effectiveness [1]. 
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Computer technologies have become an essential aspect of modern life. The fact that information can now be 

transferred at the touch of a button has posed new challenges for education [14]. In this context, it is crucial that 
prospective teachers are aware of the innovations they can use with the developing technology, that they know 

what equipment they can use, and that they have enough knowledge to use all of this [4]. 

 

Teacher trainers play an important role in preparing student teachers to integrate technology into their classrooms. 

In addition to being teachers themselves, teacher educators serve as role models for their students in teaching with 

technology, as well as in fostering students' technology literacy [15]. However, the Department of Education has 

not suggested nor provided guidance on how to use the computer and other technologies to ensure a competent 

level of technology literacy. Arguments for investing in and building information technology (IT) infrastructures 

may have displaced ideas about the usability of traditional teacher pedagogy; little attention was paid to authentic 

teacher learning in the early days of the IT movement [16]. 

 
Traditionally, teacher education providers select individual ICT courses or modules, which are often located at 

the beginning of students' qualification programme. Over the years, various frameworks, models and skills have 

been developed to guide teacher educators in their efforts to build digital capabilities in their students that will 

support them to use new and emerging technologies in their future classrooms [8]. 

 

Information competence is an integrative professional-personal quality of the future primary teacher, determining 

its readiness and ability to search for the necessary information from various sources and to process it through 

research methods [17]. A globally competent personality is oriented towards common human democratic values, 

open to intercultural dialogue, characterized by global critical thinking and proficient in modern information and 

communication technologies [18]. Innovative use of ICT is defined as the use of ICT applications that support 

educational goals based on the needs of today's knowledge society [19]. ICT integration is influenced by the 

complex of student teachers' constructivist beliefs about teaching, teaching self-efficacy, computing attitudes in 
education, and their computing self-efficacy [2]. It is believed that the integration of technology into the 

educational process by prospective teachers is mostly related to the teaching staff who train them. The fact that 

preservice teachers observe their own teachers using technology in education is a factor that encourages them to 

use technology in the future [3]. 

 

The collaborative design experience and its focus on conceptual understanding influenced preservice teachers' 

beliefs about a different type of technology than the one they were working on [6]. Another valuable role of 

technology is to increase teachers' effectiveness in organizing and presenting lessons. Lesson organization is 

facilitated by teachers being able to load lesson elements in advance (e.g., PowerPoints, videos, images, letters, 

words, etc.) and outlines guiding the flow of the lesson into the computer. As technology continues to be used at 

an ever-increasing pace and becomes increasingly important in K-12 education, the next decade will undoubtedly 
offer unprecedented opportunities for research findings to serve as the basis for improving teaching and learning 

practices. To achieve this goal, we encourage researchers to reduce efforts to prove the "effectiveness" of 

technology by focusing on conducting rigorous and relevant mixed-methods research to clarify which technology 

applications work to facilitate learning, in what ways, in what contexts, for whom, and why [20]. 

 

In recent years, there has been an increasing amount of new studies on preservice teachers' use of technology and 

their competencies in this area. However, the innovative use of technology in education has lagged behind 

expectations. Research on pre-service teachers' use of technology is expanding, but it is still much less than that 

on elementary or secondary teachers' teaching and learning with technology. Most of these studies focus on 

student teachers' qualifications to use technology to both teach and learn without discussing the implications for 

teacher educators. According to the studies, in order to integrate technology into education, educators must first 

be able to use it themselves and understand how it works [15]. In this regard, research findings show a significant 
correlation between technology literacy and the integration of pedagogical practices [16]. 

 

Prospective teachers have positive perceptions of technology use, with results indicating that those in different 

undergraduate programs have similar perceptions of technologies [12]. Despite this positive attitude, studies 

reveal that teachers' self-confidence predicts future computer use in education, both directly and indirectly, 

through its impact on attitudes toward computers in education and self-perceived computer skills [2]. 

 

In this context, the use of the concept of information competence in science is necessary for the systematic 

characterization of personality development indicators, and the formation of it should be considered in the context 

of activity [17]. However, future teachers believe that teacher educators do not sufficiently demonstrate 

technology integration behaviors in their lessons. They also state that they have a somewhat authentic experience 
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of using technology in education [3]. Pre-service teachers have critical perceptions related to technology 

integration such as effective use of technology, incorporating technology into the curriculum, increasing 
engagement, and visualizing instructional content. At the same time, they identify multiple external and internal 

barriers that prevent the integration of technology, such as lack of knowledge and ability [21]. 

 

However, the prospective teachers feel confident in their technological knowledge, which is in line with the 

current technological age. Their knowledge of e-learning concepts and their ability to select technology to support 

their learning strategies remains weak [22]. Yurt highlights the importance of future teacher careers to include 

21st century skills such as information and technology literacy, critical thinking, problem solving, 

entrepreneurship, innovation, and social responsibility [9]. In addition, the influence of contextual factors on 

technology integration processes and on the evaluation of perceived self-efficacy in digital competencies [23]. 

University tutors should assess and advise undergraduate student teachers on the effective use of technology. 

Although they have begun to incorporate technology into their curricula, they see it more as a responsibility for 
students than for themselves [13]. 

 

Teachers' observation of technology reveals how they respond to it, how they connect it to their teaching, and how 

it supports their vision of teaching and learning [14]. In this context, self-assessment plays a crucial role for both 

teachers and students. A teacher who does not feel competent will not be able to teach effectively [4]. Previous 

studies have identified numerous barriers and factors that influence the integration of ICT in teacher preparation 

programs [7]. More recent research has called for a rethinking of the outcomes of teacher education programmes, 

suggesting that the focus on digital skills should be extended to include wider models of digital competence [8]. 

However, preservice teachers believe they have sufficient knowledge of technology and are willing to use 

technology and pedagogy to deliver content. The preservice elementary teachers have satisfactory skills to 

integrate technology into their teaching practice [11]. 

 

2. IMPLEMENTATION OF THE STUDY 
The present study was conducted at the beginning of two consecutive academic years 2023/2024 and 2024/2025 

with the participation of 600 students (398 Bachelors and 202 Masters students respectively) of pedagogical 

majors in the first semester, just before the start of their training. They received a paper questionnaire but had the 

opportunity to check their answers on a computer.   

 

The purpose of this study is to assess the level of information technology proficiency of students in teacher 

education programs at the beginning of their studies, and to analyze the factors that influence these skills. In 

addition, the study aims to identify the needs for additional training and preparation in information technology 
that could assist both prospective and current teachers in the effective integration of technology into the 

educational process. 

 

Among the tasks identified are: a theoretical review of the literature, an empirical study of the students' (first-

year) skills in applying information technology, a comparative analysis of the results between bachelor's and 

master's students, identification of gaps in the students' preparation and the need for additional training, and an 

investigation of the differences between the students' self-assessment of their information technology 

competences and their actual test scores. 
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Figure 1. 

 

Fig. 1 presents the results obtained on the question on the competence of the modern teacher in the field of 

information technology. Here, 77% of respondents answer "Absolutely yes", indicating strong support for the 

need for teachers to have technology competencies. 22% answer "More likely yes", meaning that, although with 
some reservations, they also see the importance of implementatiton of technology in educational practice. Only 

1% answer "More likely no" and 0% choose "Absolutely not," indicating that almost no students think technology 

skills are not essential for teachers. 

 

The combined results clearly show that the large survey majority (99%) of respondents consider information 

technology proficiency to be important or even mandatory for today's teachers. This highlights the increasing role 

of technology in the educational process and the need for its integration into learning process. 

 

 
Figure 2. 

 

Fig. 2 presents the responses obtained to the question on students' self-assessment of their proficiency in 

information technologies. 64% of the respondents answered "More likely yes", indicating that a significant 

percentage have intermediate knowledge of information technology. 11% indicated the other positive response, 

"Absolutely yes", indicating a high level of confidence in their skills. 23% answered " More likely not", suggesting 
some uncertainty or limited technological competence. And 2% choose "Absolutely not," indicating the small 

percentage of students who are not at all proficient in information technology. This fact indicates the need for 
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additional training and development of digital skills, especially considering the increasing role of technologies in 

teachers' professional lives. 
 

 
Figure 3. 

 
The next question (Fig. 3) was dedicated to the necessity of working in a digital environment that stands in front 

of the modern teachers. 74% of participants felt that it was absolutely necessary for modern educators to be able 

to work in a digital environment, while 25% believed it was rather necessary. Only 1% considered these skills to 

be unnecessary, and not a single participant chose the option „absolutely not“. These results highlight the 

importance of digital skills in modern education, where technology plays a key role in both teaching and learning. 

Teachers who can use digital tools effectively are better prepared to engage students and adapt their methods to 

the variety of classroom needs. The tendency also reflects changes in the education system, which is increasingly 

integrating technology. 

 

 
Figure 4. 

 

Fig. 4 presents the participants' self-assessment of their ability to work in a digital environment. 61% felt that they 

could work in such an environment, while 14% stated that they "absolutely could". On the other hand, 22% 

considered that they "rather cannot" and 2% were categorical that they "absolutely cannot". These values indicate 
that the majority of participants have some level of confidence in their digital skills, but there is still a significant 
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minority who feel insecure or unable. This again may suggest the need for further training and support to improve 

digital literacy, particularly for those who are struggling. 
 

 
Figure 5. 

 
The next question was devoted to the assessment of the teachers' capacity to apply information technology. The 

largest percentage of participants (38%) considered that their teachers were " rather competent" in information 

technology, while 21% stated that they were " absolutely competent". On the other hand, 35% perceived that their 

teachers were "rather incompetent" and 6% were categorical that they were "absolutely incompetent". These 

results highlight that there is a significant gap in teachers' digital competence, which can be attributed to various 

factors such as age, training and access to resources. Although the majority of participants considered that their 

teachers had at least some level of competence, there was still a significant proportion who perceived that their 

teachers were not sufficiently prepared. This may suggest the necessity for better and more intensive training not 

only of prospective teachers but also of current teachers in the area of information technology so that they can 

effectively integrate them in their teaching. 

 
Extremely worrying is the fact that only 40% of students can name the antivirus program they use. Because it 

shows low awareness of cyber security and data protection, i.e. they may not be paying attention to the security 

of their devices, making them more vulnerable to viruses, malware and hacking attacks. This highlights the need 

for better training and awareness on the topic of cyber security. 

 

The next 20 questions were devoted to specific topics, testing the knowledge of the newly admitted students on 

the use of Microsoft office software, specifically Word, Excel and PowerPoint. The level of difficulty is not high, 

most of the questions are related to elementary functionalities, settings and tools available in the office software 

package. Extremely worrying is the fact that not a single student (out of a participation of 600) answered all 20 

questions correctly. The highest result was 16 correct answers. The average number of correct answers for 

Bachelor students was 8.67. And for Master students - 8,71. These results are also very worrying, especially 
concerning the students who have just graduated from secondary education and who should have studied a large 

number of hours of information technology and subjects of this cycle. Masters students are performing at almost 

the same level, which we can attribute to their previous education or professional career. 
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Table 1. 

By year of secondary school graduation 

  Bachelor Master 

Year 
Number of 

students 

Average Number of 

correct answers 

Number of 

students 

Average Number of 

correct answers 

2023 100 10,32 -  -  

2022 89 9,06 -  -  

2021 39 9,26 -  -  

2020 20 10,30 1           13,00  

2019 11 11,18 7           10,70  

2018 15 8,47 15           10,16  

2017 3 11,67 12           10,83  

2016 2 11,50 5             7,80  

2015 4 8,50 12             9,30  

2014 5 9,80 5           11,60  

2013 4 9,75 7           10,00  

2012 6 6,00 11             8,45  

2011 5 8,40 14             8,86  

2010 8 9,00 4             9,50  

2009 7 7,00 12             7,41  

2008 4 4,75 13             7,80  

2007 8 5,38 8             5,75  

2006 10 4,80 10           11,70  

2005 7 5,00 15             7,87  

2004 8 4,12 7           10,00  

2003 5 7,20 10             6,60  

2002 2 9,00 6             8,50  

2001 3 5,33 3             8,33  

2000 8 7,37 4             4,50  

1999 3 1,00 4             8,75  

1998 3 4,33 4           10,00  

1997 1 5,00 1             7,00  

1996 6 6,50 1             9,00  

1995 2 1,00 2             9,00  

1994 2 3,50 2             4,50  

1993 2 1,50 2             2,50  

1992 2 5,00 2             5,50  

1991 1 7,00 -  -  

1989 1 10,00 1           14,00  

1988 1 9,00 2             1,00  

1987 1 3,00 -  -  

  

Table 1 presents the average number of correct answers to the test, with students distributed by the year of their 

high school graduation. The diversity here shows us that some students continue to a bachelor's or master's degree 
after a considerable period of time, not necessarily immediately after completing their secondary education. The 

data shows that students who complete secondary education in earlier years have lower average scores than those 
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in more recent years. This may be due to factors such as knowledge outdating or lack of access to modern 

educational resources.  
 

Although the number of Masters students is smaller compared to Bachelors, their average scores are higher. These 

findings highlight the importance of context and the factors that influence educational outcomes. They also show 

that it is necessary to consider different aspects, such as age, access to resources and changes in the education 

system, when analysing the performance of newly admitted students from their previous education. 

 

Table 2. 

According to age 

  Bachelor Master 

Years 
Number of 

students 

Average 

Number of 

correct 

answers 

Number of 

students 

Average 

Number of 

correct 

answers 

53 - - 1 1,00 

52 - - 2 7,50 

51 1 9,00 - - 

50 3 4,33 - - 

49 2 5,00 2 5,50 

48 1 0,00 1 0,00 

47 3 3,33 3 6,60 

46 1 7,00 2 5,50 

45 3 4,33 2 8,50 

44 3 9,33 - - 

43 4 1,25 4 10,00 

42 3 8,33 2 12,00 

41 3 1,00 2 5,00 

40 3 6,00 4 6,00 

39 6 6,67 9 6,66 

38 9 6,89 11 7,20 

37 6 5,83 9 7,33 

36 10 3,50 12 10,75 

35 10 6,60 13 8,30 

34 5 2,80 11 8,54 

33 7 5,28 12 8,00 

32 6 8,67 8 7,50 

31 6 9,83 8 9,50 

30 8 7,25 16 8,00 

29 5 5,20 7 9,57 

28 3 10,33 9 9,66 

27 4 11,00 6 12,83 

26 5 8,00 8 8,50 

25 4 13,75 6 10,33 

24 4 7,50 11 10,27 
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23 15 9,13 14 10,92 

22 12 10,41 9 6,00 

21 25 8,92 1 8,00 

20 35 10,91 - - 

19 126 9,47 - - 

18 56 9,89 - - 

17 1 12,00 - - 

 

Table 2 visualizes the results of the participants distributed according to their age. As we can notice, it plays a 

significant role in academic achievement. Younger students, especially those 20-22 years old, show higher 

average results, while older students, especially those over 30 years old, show lower results. These observations 

can be useful for developing strategies to support students of different age groups to improve their future 

performance. 

 

The data in the table provide additional insights that may be useful for further analysis. For example, it can be 

noted that students aged 24 years who participate in master's programs have an average number of correct answers 
of 10.27, which is one of the highest performances in this group. This may be due to the fact that these students 

are at an age at which they have already gained some experience and maturity, which helps them to handle 

academic requirements more effectively. 

 

On the other hand, students aged 36 who participate in undergraduate programmes have an average number of 

correct answers of 3.50, which is one of the lowest performances. This may be explained by the fact that these 

students may have returned to education after a long break and may be having difficulty adjusting to the academic 

requirements. It is interesting to notice that students aged 28 years, in both Bachelor and Master programmes, 

show relatively high average scores - 10.33 for Bachelors and 9.66 for Masters. This may be due to the fact that 

at this age the participants are young enough to be motivated and energetic, but also have some life experience 

that helps them to perform better in academic tasks. 

 
Table 3. 

 

According to the specialty in which they are studying 

Specialty 
Number of 

students 

Average 

Number of 

correct 

answers 

Pre-school and elementary school pedagogy 193 9,31 

Elementary school pedagogy 109 9,48 

Pre-school pedagogy 83 7,80 

Special pedagogy 65 5,79 

Social pedagogy 57 7,61 

Physical education and sport 38 9,00 

Elementary school pedagogy with a foreign language 29 9,72 

Pre-school school pedagogy with a foreign language 18 8,72 

Pedagogy of art education 8 10,62 

 

The next table (number 3) shows the average number of correct answers given by students, distributed according 

to the major they enrolled in. The largest group chose the major " Pre-school and elementary school pedagogy ", 
with a total number of 193 students. The average number of correct answers for this group was 9.31, indicating 

relatively good academic performance. This may be due to the fact that this specialty is among the most popular 

and probably attracts students with high motivation and interest in education. 
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The highest scores were obtained by students from the specialisation "Pedagogy of art education", who also had 

the lowest number (8). The second best performing group includes students from the specialty "Elementary school 
pedagogy with a foreign language", followed by "Elementary school pedagogy". The lowest results are shown by 

the students of the specialty "Special pedagogy".  This could be explained by a variety of factors, such as a 

different curricular focus or greater preparation challenges. In general, the analysis of the results suggests that the 

number of students in a specialty does not always correlate with their achievement, and that motivation and the 

specificity of the training play a central role in academic success. This may be useful information for future 

educational reforms or changes in teaching methodology in different majors. 

  

Table 4. 

Question 

Total 

number of 

correct 

answers 

Percent

age 

ratio 

Master Bachelor 

Which menu can be used to set the line 
spacing? 401 67% 143 71% 258 65% 

How can the selected letters be made 

uppercase? 416 69% 135 67% 281 71% 

How can you make the indentation at the 

beginning of each paragraph? 89 15% 26 13% 63 16% 

By selecting which menu can you determine 

the amount of indentation to the page margins? 110 18% 53 26% 57 14% 

Restoring an old position when working in a 

text document is done with the command: 387 65% 149 74% 238 60% 

Which button is used to split a table: 324 54% 108 53% 216 54% 

The Select Cell command is used to highlight: 286 48% 104 51% 182 46% 

On which panel of the Format menu are the 

buttons for selecting the location of a graphics 

form and a graphics schema: 152 25% 51 25% 101 25% 

On which panel of the Layout menu are the 

cell split and merge buttons located: 221 37% 80 40% 141 35% 

The Number tab of the Format Cells dialog 

box is used to set: 117 20% 35 17% 82 21% 

In what order to perform the sorting is 

specified: 169 28% 64 32% 105 26% 

On which panel of the Insert menu are the 

buttons for inserting diagrams: 187 31% 76 38% 111 28% 

In the electronic spreadsheets, when cell 

addresses are involved in the formulas, they 

can be: 233 39% 69 34% 164 41% 

Which of the functions will return the correct 

answer if we want the value in cell C1 to be at 
least 10? 342 57% 116 57% 226 57% 

Which of the functions will return the correct 

answer if we want the value in cell B1 to be at 

least 5? 280 47% 90 45% 190 48% 

Which function will check whether the student 

is eligible to participate in the basketball team, 

namely: be taller than 175 cm and lighter than 

75 kg? (If his height is listed in cell C2 and 

weight in cell E2) 138 23% 43 21% 95 24% 

On which panel of the Insert menu are the 

buttons for inserting video and sound: 473 79% 156 77% 317 80% 

Which panel of the Animations menu is used 

to assign animation effects to a slide element? 237 40% 60 30% 177 44% 
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With the Trim Audio (Trim Video) command: 296 49% 93 46% 203 51% 

When printing a presentation, which option is 

used to print only the current slide: 353 59% 111 55% 242 61% 

 

The data in the table show interesting trends in the knowledge and skills of bachelor and master students in regards 

to technical and software competencies. First, students demonstrated the highest success in questions related to 

basic text editor functions. For example, the question about converting letters to capital letters had the highest 
percentage of correct answers - 69% of all participants. This shows that basic text manipulation skills are well 

mastered by both Bachelors (71%) and Masters (67%). This result can be explained by the fact that working with 

text-processing programs is a major part of daily academic and professional practice, leading to a good familiarity 

with these functions. 

 

However, for more specific and technical issues, the success rate decreases significantly. For example, only 18% 

of students correctly answered the question about identifying indentation from the margins on the page. It is 

interesting that Masters students show better results (26%) compared to Bachelors (14%). This may be due to the 

greater experience of Masters students in working with documents, making them more confident in using more 

sophisticated features of text editors. This highlights the importance of continuing education and skills 

development in masters programmes. 
 

For questions related to working with tables and graphs, the success rate is moderate. For example, 54% of the 

students answered the question on splitting tables correctly, with both bachelor and master groups showing similar 

results (53% and 54% respectively). However, for more specific functions, such as the use of tab "Number" to 

format cells, the success rate was significantly lower, with only 20% of students answering correctly. This may 

be due to the more complex nature of these tasks, which require a deeper understanding of the software tools. 

 

In addition, questions related to the use of condition checking functions also showed lower success rates. For 

example, only 23% of students correctly answered the question about checking conditions for participation on a 

basketball team. This highlights that participants struggle with applying logic functions that require a higher level 

of rational thinking. 

 
The question on embedding video and sound in a presentation was the best answered by students, with 79% 

answering correctly, probably because this is a commonly used feature in the learning process by both teachers 

and students. And the lowest score was obtained on the question "How can you make the indentation at the 

beginning of each paragraph?". The low score on this question could be due to several possible reasons. One of 

them is that students are not sufficiently familiar with text formatting settings in text-processing programs, 

probably because their training places more emphasis on the content of the text than on its layout. This may 

suggest a need for more practical exercises related to text formatting to enhance students' ability to structure their 

documents in a professional style. 

 

In general, the data show that students are more confident with the basic functions of word processing and 

spreadsheet editors, but struggle with more specific and technical aspects. Masters students show a slight 
advantage in some areas, which may be due to their more advanced training and experience. This highlights the 

need for better training and education in software tools, especially for the more complex functions that are 

essential for academic and professional tasks. 

 

Analysis of the obtained results 

The obtained arithmetic mean shows that the average number of correct answers of student’s bachelors is 8,67, 

with n = 398. Correspondingly, for master’s students, we have an average number of correct answers of 8.71, with 

n = 202. This shows that both groups have very similar mean scores, suggesting that there is no significant 

difference in overall success rates between bachelors and masters students. This can be explained by the fact that 

both groups are subjected to similar educational requirements and standards. 

 
Considering that the standard deviation indicates how close or far from the mean performance the students' scores 

are, in our case we obtain σ = 3.867751674 for bachelors and σ = 4.183506 for masters. This shows that the results 

of masters students are slightly more dispersed compared to those of bachelors students. This may be due to the 

greater heterogeneity in training, experience and interests of masters students, who may have more diverse 

academic and professional goals. The standard deviation itself is a nominal variable and not suitable for 

comparison. Therefore, we also calculate a coefficient of variation, specifically Vσ% = 44.61074596 for bachelors 
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and Vσ% = 48.03106954 for masters. It is assumed that when it is below 50%, it means that the variance is small 

(or negligible). Since both coefficients are below 50%, this indicates that the variance of the results is relatively 
small, meaning that most students performed close to the mean. However, the slightly higher coefficient for 

masters students highlights that their results are slightly more varied than those of bachelors students. 

 

Тhe skewness coefficient for bachelor's students is -0.40, while for master's students, it is -0.27. This indicates 

that the distribution of results is slightly negatively skewed, meaning that there are more students with higher 

scores compared to those with lower scores. The kurtosis coefficient for bachelor's students is -0.39, while for 

master's students, it is -0.51. This indicates that the distribution of results is flatter compared to the normal 

distribution, meaning there are fewer extreme values. The range of results for bachelors is 16 and for masters is 

19. This indicates that masters students have a wider range of results, which may be due to the greater 

heterogeneity in their knowledge and skills. 

 
Then, we calculate the standard error of the mean. We obtain μ = 0.193872873 for bachelors and μ = 0.294350455 

for masters. This indicates that the average for bachelors is more stable and less vulnerable to random variation 

than that for masters. Based on the standard error, the maximum allowable error is calculated, which has greater 

interpretative significance. The maximum allowable error is usually denoted by ∆ and is calculated using the 

formula: ∆ = 𝑡. 𝜇 , where t is a guarantee multiplier whose value depends on the guarantee probability with which 

we want to guarantee our conclusions. Usually, we work with a guarantee probability of 95%, where the guarantee 

multiplier t = 1.96. Therefore, the maximum error for this guarantee probability, calculated using the above 

formula, we obtain ∆ = 0.379990832 for bachelors and ∆ = 0.576926892 for masters. This means that we can state 

with 95% confidence that the true mean of the results lies in the range 8.29 to 9.05 for bachelors and 8.13 to 9.29 

for masters. This shows that although both groups have similar means, the confidence interval for the masters is 

slightly wider, again highlighting the greater variation in their results. The findings highlight the need for targeted 
learning approaches to meet the specific needs of each group of students.  

 

3. CONCLUSION 
The present study provided an analysis of the information technology application skills of students in education 

majors and their implication for modern education. The results clearly show that almost all respondents believe 

that information technology proficiency is essential for the teaching profession. However, a significant proportion 

of students do not feel fully confident in their digital skills, indicating a need for further training and development 

in this area. 

 
An analysis of students' self-assessment of working in a digital environment reveals that while most feel relatively 

prepared, there is still a group that experiences uncertainty or confidence in using technology. This is particularly 

important in the context of the increasing role of technology in the educational process. At the same time, the 

results of the evaluation of the digital competences of their lecturers show a significant gap - a large percentage 

of students feel that their lecturers are not sufficiently prepared in this area. 

 

Particularly worrying is the fact that fewer than half of students can name the antivirus program they use, 

indicating a low level of cyber security awareness. This highlights the need for more profound training in this 

area, as a lack of knowledge and skills in protecting personal and professional data can lead to serious problems 

in the professional practice of future teachers. 

 
The results of the basic skills test show that no student was able to answer all questions correctly, and the average 

number of correct answers was relatively low for both undergraduates and postgraduates. This is indicative of the 

need for further training and practical improvement in the use of basic office applications such as Word, Excel 

and PowerPoint, which are fundamental not only to the teaching profession. 

 

The analysis also shows that age and year of secondary school graduation have an impact on results, as younger 

students and recent graduates show better results compared to older participants. This suggests that technological 

competencies change over time and require constant updating and adaptation. 

 

In conclusion, the study clearly outlines the need for more in-depth and practically oriented preparation of future 

teachers in the field of information technology. Despite the high awareness of the importance of technology in the 

educational process, the actual level of skills in the area of technology competences remains unsatisfactory, which 
requires a rethinking and improvement of training programmes in this direction. 
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Limitations of the study include: limited scope of the study group; unstudied external factors; existing differences 

in participants' previous education, year of graduation, age and work experience; limited time period; limited 
scope of skills tested; lack of analysis of the impact of socioeconomic factors and potential for subjectivity in 

responses. 

 

After the conducted research, we can identify the following recommendations: the need to conduct targeted 

courses dedicated to information technology (disciplines should cover not only basic applications, but also 

interactive educational platforms, cybersecurity, digital teaching methodologies and the use of AI tools in 

education); Regular evaluation and updating of school curricula (schools should periodically update curricula in 

line with technological trends and labour market requirements); Creating additional online resources and digital 

libraries to support future educators (Access to specialized materials, video tutorials, and interactive platforms 

will help students improve their skills in self-directed learning); Establish better collaboration with schools 

(partnerships between universities and schools can lead to better preparation of future educators); Conduct further 
research ( continued research is needed in the area of digital competencies of pre-service teachers, tracking the 

long-term outcomes of training and its impact on the practical work of graduate educators). 
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